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Introdução

O termo ‘crescimento’ de 
plantas distingue acréscimo 
de tamanho e, ou massa, re-
gistrado ao longo do ciclo fe-
nológico, e tem caráter quan-
titativo. Já o termo ‘desenvol-
vimento’ é mais abrangente e 
envolve todas as mudanças 
qualitativas (diferenciação) e 
quantitativas (crescimento) 
experimentadas pela planta 
(Cairo et al., 2008). Por isso, 
é mais fácil analisar dados de 
crescimento, sobretudo de fo-
lhas. Uma folha completa 
apresenta as seguintes estru-
turas: limbo, pecíolo ou bai-
nha, e um par de apêndices 
foliares chamados estípulas na 
base do pecíolo (Vidal e 
Vidal, 2007). Em maior pro-
porção, tem-se que o acúmulo 
de biomassa vegetal acumula-
da pelas plantas, resulta da 

atividade fotossintética, prin-
cipalmente no limbo foliar e o 
restante advém da absorção 
de nutrientes minerais do 
solo, sendo este um fator in-
centivador para se estimar a 
área foliar de uma planta 
(Kerbauy, 2012).

Diante disso, a estimativa 
da área foliar pode ser reali-
zada por meio de diferentes 
métodos, divididos em destru-
tivos e não destrutivos, os 
quais na maioria dos estudos 
são utilizados para estimar o 
crescimento da planta ou do 
órgão de interesse, seja causa 
de variações de plantas gene-
ticamente diferentes ou de 
plantas que crescem em am-
bientes diferentes (Martin 
et al., 2013). Entretanto, a es-
colha do método dependerá 
do objetivo e cronograma do 
pesquisador, da disponibilida-
de de plantas, mão-de-obra e 

equipamentos, pois quando se 
planeja uma maior frequência 
de coleta de material vegetal 
é inviável, por exemplo, ana-
lisar a área foliar de cada fo-
lha de um volume grande de 
amostras. Assim, estimar a 
área foliar baseando-se em 
medições rápidas pode ser 
muito ef icaz em agilizar o 
processamento das amostras 
(Cairo et al., 2008).

Medições rápidas podem ser 
realizadas precisamente por 
equipamentos denominados 
‘integradores de área foliar’, 
tidos como método padrão, 
mas por serem de custo eleva-
do ainda são inviáveis para as 
condições comuns de pesqui-
sas (Martin et al., 2013). Em 
substituição, tem-se utilizado 
diferentes softwares, licencia-
dos e gratuitos, para estimar a 
área foliar por meio do proces-
samento da imagem digital da 

folha da planta (Adami 
et al., 2008; Embrapa, 2014; 
SigmaScan, 2014). Dentre os 
softwares gratuitos, o Image 
Processing and Analysis In 
Java (ImageJ, 2014), é usado 
em várias áreas do conheci-
mento e em análises muito 
complexas (Laurecen e 
Chromy, 2010). Embora pouco 
utilizado no Brasil tem-se en-
contrado resultados satisfató-
rios para ser usado em substi-
tuição ao método do integra-
dor de área foliar (LI3100 LI-
COR) (Martin et al., 2013).

Diante disso, objetivou-se 
neste trabalho estimar a área 
do limbo foliar de plantas de 
algodão, caju, soja e milho, 
baseando-se em medidas line-
ares e de massa seca, por 
meio da calibração prévia das 
imagens digitais dos limbos 
de diferentes tamanhos no 
software ‘Image J’.
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RESUMO

Grande parte da matéria seca acumulada pelas plantas advém 
da fotossíntese nas folhas. Por isso, a análise do crescimento fo-
liar é útil para o estudo vegetal sob diferentes condições edafocli-
máticas. A área foliar pode ser estimada por diferentes métodos 
e equipamentos, alguns onerosos e demorados, inviáveis para as 
condições comuns de pesquisas. Entretanto, podem existir alterna-
tivas econômicas e rápidas por meio do uso de softwares proces-
sadores de imagens, gratuitos ou não. Diante disso, objetivou-se 
estimar a área do limbo foliar de diferentes plantas baseando-se 
em medidas lineares e de massa seca, calibradas com o softwa-
re gratuito ‘ImageJ’. As folhas das plantas de algodoeiro (Gos-
sypium hirsutum L) cultivar IMACD 6001, cajueiro (Anacardium 
occidentale L) cultivar FAGA 10, soja (Glycine max L) cultivar 

M-SOY 7639RR, e milho (Zea mays L) cultivar Penta TL foram 
coletadas no terço inferior, médio e superior em diferentes fases 
fenológicas. Verificou-se que se pode usar imagens com resolução 
de no mínimo 7,2 megapixels para estimar a área real do limbo 
foliar, e processadas no software ImageJ com até 324cm2 de área. 
Para superfícies maiores, recomendam-se testes com câmera de 
resolução superior ou que a folha, de dimensões maiores, seja 
recortada em pedaços de até 324cm2. Observou-se elevada expli-
cação na estimativa da área do limbo foliar baseando-se em me-
didas lineares e de massa seca, logo recomenda-se estimar a área 
foliar de folhas com limbos danificados ou de várias amostras de 
folhas coletadas à campo com base na massa seca das folhas, por 
ser operacionalmente viável.
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7639RR, and corn (Zea mays L) var. Penta TL were collected 
from the lower third, middle and top in different phenological 
phases. It was found that images with a resolution of at least 
7.2 megapixels can be used to estimate the actual leaf blade 
area, processed with the ImageJ software till 324cm2. For 
larger surfaces, we recommend testing with higher resolution 
camera, or cut a large sheet into pieces up to 324cm2. We 
observed a good agreement in the estimation of the leaf blade 
area based on linear and dry mass measures and, therefore, 
it is recommended to estimate leaf area leaves with damaged 
pieces or measures from several samples of leaves collected 
at the field based on the dry weight of the leaves, as it is op-
erationally viable.

SUMMARY

Much of dry matter accumulation by plants comes from 
photosynthesis in the leaves. Therefore, analysis of leaf 
growth is useful for plant study under different climatic and 
soil conditions. Leaf area can be estimated with different 
methods and equipments, some of which are costly and time 
consuming, ineffective for common research conditions. How-
ever, there can be alternatives, economic and fast, through 
the use of imaging software, free or licensed. Thus, we aimed 
to estimate the area of the leaf blade of different plants based 
on linear and dry weight measures, calibrated with the free 
software ImageJ. The leaves of cotton plants (Gossypium hir-
sutum L) var. IMACD 6001, cashew (Anacardium occiden-
tale L) var. FAGA 10, soybean (Glycine max L) var. M-SOY 
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del tercio superior, médio y inferior, en distintas fases fenoló-
gicas, de plantas de algodón (Gossypium hirsutum L) cultivar 
IMACD 6001, marañon (Anacardium occidentale L), variedad 
FAGA 10, de soya (Glycine max L) cultivar M-SOY 7639RR, y 
maíz (Zea mays L) cultivar Penta TL. El software ImageJ puede 
ser utilizado para estimar área foliar con superfície inferior a 
324cm2 e imágenes con resolución mínima de 7,2 megapíxeles. 
Para mayores superficies se recomienda usar imágenes de mejor 
resolución, o el fraccionamento de las hojas en trozos de hasta 
324cm2. La estimación del área de la lámina foliar por medición 
lineal y matéria seca fue eficiente, por lo tanto para determina-
ciones de láminas dañadas o un gran número de muestras se 
recomienda el empleo de la matéria seca.

RESUMEN

Gran parte de la acumulación de materia seca  en plantas 
proviene de la fotosíntesis foliar. El análisis del crecimiento de 
las hojas es útil para el estúdio de los vegetales bajo diferentes 
condiciones edafoclimáticas. El área de la hoja puede estimarse 
por diferentes métodos y aparatos, algunos costosos y cuyo fun-
cionamiento requiere tiempo, lo cual los hacen ineficientes para 
las condiciones comunes de investigación. Sin embargo, el uso 
de algunos softwares procesadores de imágenes, libres o no, 
puede ser una alternativa más económica y rápida para una 
adecuada determinación del área foliar. El objetivo del presente 
trabajo fue estimar la superfície de la lámina foliar de difer-
entes plantas por medidas lineales y materia seca, ajustadas por 
el software libre ‘ImagenJ’. Para eso fueron recolectadas hojas 

Material e Métodos

As folhas de diferentes espé-
cies de plantas foram coletadas 
no terço inferior, médio e supe-
rior em diferentes tamanhos, 
idades fenológicas e fases feno-
lógicas das plantas. Elas foram 
amostradas no período de 
05/11/2013 a 10/06/2014.

As espécies de plantas e 
seus respectivos históricos 
foram:

i- Algodoeiro (Gossypium hir-
sutum L) cultivar IMACD 
6001, retiradas de uma unida-
de experimental de 0,16ha, 
cultivado em espaçamento 
0,90m entre linhas e 12 plan-
tas por metro linear, em lati-
tude de 15º48’10’’S, longitude 
de 54º26’47’’O e altitude de 

435m, em NEOSSOLO 
Q U A R T Z A R Ê N I C O 
Distróf ico, relevo plano 
(Embrapa, 2006). Descontou-
se 3,6m de bordadura e, a 
amostragem consistiu na reti-
rada ao acaso de 32 folhas.

ii- Cajueiro (Anacardium occi-
dentale L) cultivar FAGA 10, 
apanhadas de uma unidade 
experimental de 0,324ha com 
cajueiros adultos. Os cajueiros 
foram plantados em 2003, 
quando ainda eram mudas, no 
espaçamento de 7,5x8,0m, a 
15o47’11’’S e 56o 04’47’’O, alti-
tude de 140m, em um 
NEOSSOLO QUARTIZA-
RÊNICO Órtico êutrico, A 
moderado, fase cerrado, relevo 
plano (Embrapa, 2006). 
Selecionaram-se três plantas 

centrais e a amostragem con-
sistiu na retirada ao acaso de 
35 folhas.

iii-Soja (Glycine max L) culti-
var M-SOY 7639RR, apanha-
das de uma unidade experi-
mental de 10ha, cultivado em 
espaçamento de 0,45m entre 
linhas e média de 10 plantas 
por metro linear, a 
14º07’40,7’’S e 56º58’39,59’’O 
e altitude de 539m, em 
LATOSSOLO VERMELHO-
AMERELO Distrófico, relevo 
suave ondulado (Embrapa, 
2006). Descontou-se 10m de 
bordadura e, a amostragem 
consistiu na retirada, ao acaso 
de 25 folhas.

iv- Milho (Zea Mays L) culti-
var Penta TL, apanhadas de 

uma unidade experimental de 
10ha, cultivado em espaça-
mento de 0,45m entre linhas e 
média de três plantas por me-
tro linear, a 14º07’40,7’’S, 
56º58’39,59’’O e altitude de 
539m, em LATOSSOLO 
VER MELHO-AMAR ELO 
Distróf ico, relevo suave 
ondulado (Embrapa, 2006). 
Descontou-se 10m de borda-
dura e, a amostragem consis-
tiu na retirada, ao acaso de 
28 folhas.

Em função do murchamen-
to, as folhas eram arrancadas 
na ordem de uma por vez, 
fotografadas imediatamente, 
para posteriormente obter as 
medidas lineares (comprimen-
to e largura) e de área foliar, 
utilizando o software 
(Figura 1). Os detalhes da 
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obtenção das fotograf ias à 
campo são descritos as seguir.

Para determinar a área real 
do limbo foliar das diferentes 
plantas, inicialmente as ima-
gens foram obtidas via máqui-
na fotográfica digital (Sony 
DSC-W110) utilizando resolu-
ção de 7,2 megapixels, sem o 
uso do flash para evitar refle-
xos, a uma distância perpendi-
cular de 0,30m. Para isso, 
fez-se o uso de uma prancheta, 
uma folha A4 branca com es-
cala desenhada de 2cm, além 
de um plástico rígido de acríli-
co transparente para prensar a 
folha com a face superior sobre 
o papel. As imagens foram 
obtidas sob iluminação solar, e 
em seguida transferidas para o 
computador. Posteriormente, as 
imagens foram processadas 
utilizando-se o software de 
domínio público, denominado 
‘ImageJ’ (ImageJ, 2014; 
Figura 2). A seguir tem-se a 
ordem sequencial das análises.

i- Abriu-se a imagem pelo pro-
grama: File > Open e definiu-se 
o que medir (Analyze >Set 
Measurements >Area >Ok).

ii- Definiu-se a escala, clican-
do no ícone Magnifying glass 
para aproximar da escala dese-
nhada (botão esquerdo do 
mouse) na folha A4 e, em se-
guida a sublinhou, selecionan-
do o ícone Straight. Depois, 

clicando no ícone Magnifying 
glass para reduzir o zoom (bo-
tão direito do mouse) registrou-
-se a escala em: Analyze >Set 
scale >Know distance= 2 
>Unit of lenght= cm, que foi a 
unidade de medida adotada.

iii- Eliminou-se o que não era 
folha, selecionando o ícone 
Freehand selections para contor-
ná-la e, depois em Edit >Clear 
outside retirou-se a bordadura.

iv- Converteu-se a imagem em 
tons de cinza: Image >Type >8 
bit. Depois a segmentou em cor 
preto e branco em: Image 
>Adjust >Threshold >Apply. 
Nesse processo de segmentação é 
importante haver contraste entre 
o fundo (papel A4) e a folha, 
pois pode acontecer de regiões da 
folha não serem contabilizadas. 
Isso acontece geralmente por 
causa de reflexos, pouco contras-
te e, ou nervuras foliares claras. 
Se isso acontecer é necessários 
contornar as regiões com 
Paintbrush Tool e depois preen-
cher com Flood Fill Tool. Além 
disso, pode haver pontuações 
brancas no interior das imagens, 
mas desde que não seja devido à 
ação de doenças e insetos, pode-
-se eliminá-las em: Process 
>Binary >Fill holes. Casso essas 
correções sejam necessárias é 
necessário realizar novamente a 
segmentação (Image >Adjust 
>Threshold >Apply).

v- Por fim, obtiveram-se os re-
sultados de área foliar em: 
Analyze >Analyze particles 
>Summarize >OK. Na obtenção 
de imagem com várias folhas, é 
possível realizar uma única aná-
lise e conhecer a medida de 
área de cada folha selecionando: 
Show >Outlines em: Analyze 
>Analyze particles e OK.

Posteriormente, obteve-se a 
imagens segmentadas (preto e 
branco) dos limbos foliares das 
plantas, com exceção da soja, 
que devido à ondulosidade no 
interior e nas bordas dos limbos, 
observou-se que foi necessário 
recortá-los para evitar sobreposi-
ção, e consequentemente, erros 
de medidas, durante a prensa-
gem para a obtenção das foto-
grafias no campo (Figura 3).

Em substituição aos ‘apare-
lhos integradores de área foliar’, 
para calibrar e validar o progra-
ma ‘ImageJ’, que estimou a 
área de limbo foliar das folhas, 
inseriu-se no Microsoft Word 
em: inserir >formas, quadrados 
preenchidos de cor verde pa-
drão, simulando a cor natural 
das folhas, com lados conheci-
dos (1, 2, 3, ..., 18cm), ou seja, 
com área de 1, 4, 9, 16, 25, 36, 

49, 64, 100, 121, 144, 169, 196, 
225, 256, 289 e 324cm2, respec-
tivamente. Assim como no cam-
po, a uma distância de 0,30m, 
fotografou-se cada quadrado 
impresso, um por vez, manten-
do o plástico rígido transparente 
para prensar o papel na pran-
cheta. Posteriormente, as ima-
gens foram processadas no 
ImageJ para comparar com a 
área real dos quadrados do 
Microsoft Word e, assim, vali-
dar o método para as folhas.

Todos os dados apresentaram 
homoscedasticidade pelo teste de 
Levene e normalidade pelo teste 
de Shapiro-Wilk ao nível de 5% 
de probabilidade (SigmaPlot, 
2014). Em seguida, fez-se o ajus-
te dos pares de dados obtidos 
pela área estimada com o 
ImageJ por meio da foto digital 
dos quadrados vs área real dos 
quadrados (Microsoft Word-
MW). Como o ajuste anterior foi 
validado, isto é, de que a área 
estimada pelo ImageJ é a mes-
ma dos quadrados do Microsoft 
Word, a área real das folhas foi 
determinada a partir de então 
por este software. Diante disso, 
comparou-se a área ‘real’ dos 
limbos foliares das plantas 

a b

c d

Figura 1. Imagens digitais de limbos foliares em cor cinza de plantas de: 
algodão (a), caju (b), soja (c) e milho (d). Obs. A medida de comprimen-
to foi realizada paralelo ao sentido da nervura principal.

Figura 2. Menu do programa computacional Image Processing and 
Analyse In Java (Image J, 2014).

a b

c d

Figura 3. Imagens de limbos foliares recortadas e segmentadas em preto e 
branco no ‘ImageJ’ de plantas de: algodão (a), caju (b), soja (c) e milho (d).
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estimada via ImageJ com: i) a 
área estimada por medidas line-
ares (comprimento vezes largu-
ra); e ii) com a massa seca do 
limbo foliar das plantas, na ten-
tativa de estimar a área do lim-
bo foliar.

Todas as comparações foram 
ajustadas por meio de regres-
são, conforme o modelo polino-
mial linear crescente (yi = y0 + 
bx + ei), em que y0 e b foram 
os coeficientes estimados, sendo 
ei o erro de estimativa. A acurá-
cia do ajuste foi avaliada pela 
significância dos coeficientes a 
e b; pelos coeficientes de corre-
lação de Pearson (r) e determi-
nístico (R²), além do erro pa-
drão da estimativa do ajuste, 
em que valores próximos de 1 e 
0 são os desejados, respectiva-
mente (Larson e Farber, 2010). 
Para avaliar se o erro padrão da 
estimativa do modelo estatístico 
poderia comprometer o uso dos 
valores oriundos da estimativa 
da área do limbo foliar pela 
massa seca, considerando as 
culturas de soja e milho avalia-
das e no mesmo talhão de cul-
tivo, coletou-se mais de 50 
plantas em diferentes estádios e 
distribuídas no espaço para 
comparar o desvio padrão do 
ajuste com o intervalo de con-
fiança da média ( = 0,05) da 
área foliar por estádios. Além 
disso, como o coeficiente de 
correlação ‘r’, na maioria dos 
casos, não avaliam concordân-
cia e sim associação, a equiva-
lência entre a área estimada 
com o ImageJ por meio da foto 
digital dos quadrados vs área 
real dos quadrados (Microsoft 
Word-MW) foi avaliada pelo 
índice de concordância de 
Willmott e pelo índice de de-
sempenho de Carmargo e 
Sentelhas (1997); e o limite de 
concordância proposto por 
Bland e Altman (1986).

Resultados e Discussão

Na Tabela I são apresentados 
os resultados, e na Figura 4a, o 
gráfico que confronta os pares 
de dados ajustados entre área 
estimada usando o ImageJ  ver-
sus área real dos quadrados do 
Microsoft Word, de modo a 
averiguar se as duas medidas 
são equivalentes e se o primeiro 
poderia substituir o segundo, ou 

seja, se existe ou não concor-
dância. Observa-se com base no 
coeficiente determinístico (R2) 
que a imagem obtida via câme-
ra fotográfica digital e poste-
riormente processada no ImageJ 
explicou 99,99% da variação da 
área real dos quadrados, no in-
tervalo de 1 a 324cm2, com um 
erro padrão médio de estimati-
va de apenas 0,8320cm2.

Além disso, embora o grau 
de correlação não avalie con-
cordância e sim associação de 
casos bem distintos, no presente 
trabalho, esse índice foi confiá-
vel, pois o coeficiente angular 
foi próximo a 1 e o intercepto 
igual à 0, condizente com a reta 
da igualdade (1:1) (Figura 4a). 
De modo a corroborar, averi-
guou-se a concordância pelo 
método de Willmott (d), no 
qual quanto mais próximo de 1, 
mais forte (ou perfeita) é a con-
cordância entre os métodos, e 
obteve-se o valor d= 0,999 que 
reflete uma perfeita concordân-
cia e, quando multiplicado pelo 
coeficiente de correlação para 
encontrar o índice de desempe-
nho de Camargo-Sentelhas 
(c= r·d), o mesmo foi classifica-
do como ‘ótimo’ (c ≥0,85) 
(Tabela I). Esse resultado da 
comparação do ImageJ com 
quadrados do Microsoft Word 
foi melhor até mesmo que as 
comparações obtidas pelo inte-
grador de área foliar obtidas 
por Martin et al. (2013), o que 
descarta a necessidade do uso 
desse equipamento para realizar 
a calibração de um software.

No entanto, verificou-se cer-
ta tendência da diferença entre 
os dois métodos em aumentar 
o erro de estimativa, à medida 
que aumentava a área dos qua-
drados (Figura 4b), e isso auxi-
lia no entendimento da supe-
restimação dos valores a partir 

de 200cm2 (Figura 4a), porque 
o comportamento esperado é 
uma distribuição aleatória das 
diferenças em torno da média 
dos métodos. A vantagem do 
método de Bland-Altman em 
complementar os resultado dos 
índices de Willmott e 
Camargo-Sentelhas é que inclui 
os limites de concordância e 
seus intervalos de confiança e, 
assim, pode-se inferir se os li-
mites encontrados são aceitá-
veis do ponto de vista técnico, 
pois nesse método a concor-
dância dos métodos é avaliada, 
levando em consideração o 
viés (o quanto as diferenças se 
afastam do valor 0), o erro (a 
dispersão dos pontos das dife-
renças ao redor da média), 
além de outliers e tendências.

Diante disso, como os limites 
de concordância representam a 
região em que se encontram no 
mínimo 95% das diferenças das 
medidas estudadas (Figura 4b), 
ao considerar a área estimada 
do maior quadrado (324cm2) 
verificou-se uma variação de 
-2,2972 e +7,8147cm2, que re-
presenta uma subestimativa de 
0,70% e superestimava de 
2,41%, valores abaixo dos 5% 

de erro comum usado em expe-
rimentos agronômicos, além 
disso, conforme Hair et al. 
(2005) ‘valores maiores depois 
de serem previstos’ naturalmen-
te tem resíduos maiores. 
Portanto, do ponto de vista 
agronômico pode-se usar ima-
gem de folhas fotografadas por 
câmera digital de resolução no 
mínimo de 7,2 megapixels para 
estimar a área foliar real, e pro-
cessadas no software ImageJ 
até 324cm2 de área. Portanto, 
ao utilizar valores maiores que 
este, recomenda-se uma máqui-
na fotográfica digital com reso-
lução superior ou que se recorte 
as folhas com dimensões maio-
res em pedaços menores e/ou 
iguais a 324cm2.

Do pressuposto, tendo valida-
do o método de estimativa da 
área real de imagens digitais 
processadas no software ImageJ, 
em seguida fizeram-se regres-
sões polinomiais do 1º grau com 
o objetivo de comparar a área 
real dos limbos foliares com a 
possibilidade do uso de medidas 
lineares e de massa seca dos 
mesmos em estimar essa área 
real (Tabela II). No geral, inde-
pendente das plantas estudadas, 
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Figura 4. Regressão entre os pares de dados entre área estimada via 
ImageJ versus área real dos quadrados (a); Análise de concordância de 
Bland-Altman, em que a média (linha contínua) foi de 2,7588cm2, e os 
limites de concordância, linhas pontilhadas, foram de -2,2972 e 
7,8147cm2, inferior e superior, respectivamente (b).

TABELA I
RESULTADOS OBTIDOS NO AJUSTE DOS PARES DE DADOS 

ENTRE ÁREA ESTIMADA VIA IMAGEJ vs ÁREA REAL DOS QUADRADOS
Intercepto Coeficiente

N r R2 d c Prob. Fc>Ft1 EPE
y0 a

0,009 ±0,299*** 1,023 ±0,002*** 25 0,999 0,998 0,999 0,999 <0,0001 0,832

Utilizou-se o modelo linear (AIJ= y0+b.AMW), em que: AIJ: área estimada via ImageJ, AMW: área real dos 
quadrados (Microsoft Word) e y0 e a: coeficientes estimados; N: número de pares de dados usados para ajustar 
o modelo; r: coeficiente de correlação de Pearson (p<0,0001); R2: coeficiente determinístico; d: índice de concor-
dância de Willmott; c: índice de desempenho de Carmargo-Sentelhas; EPE: erro padrão da estimativa ( = 0,05).
1 Probabilidade pelo teste de Tukey.
*** (p < 0,0001) significativo pelo teste t.
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a c e g

b d f h

Figura 5. Regressão entre os pares de dados de área estimada via imagem digital processada no ImageJ vs 
valores de medidas lineares dos limbos foliares das plantas de algodão (a), caju (c), soja (e) e milho (g); e vs 
valores de medidas de matéria seca de plantas de algodão (e), caju (d), soja (f) e milho (h).

observou-se elevada associação 
entre os ajustes, demonstrado 
pelo coeficiente de Person, maior 
que 0,90, que segundo Martin 
et al. (2013), está em conformi-
dade com a literatura. Ainda, 
com base no coeficiente deter-
minístico (R2) observa-se que 
tanto o método de medida linear 
quanto o uso da massa seca ex-
plicaram, na maioria, mais de 
90% da variável dependente 
(área real dos limbos foliares) e 
isso foi garantido pela distribui-
ção equilibrada e pelo pouco 
desvio verificado entre os pares 
de valores de cada observação e 
a função estatística linear ajusta-
da (Figura 5).

Além disso, conforme Hair 
et al. (2005), quando uma análi-
se de regressão é baseada em 
uma amostra da população é 
apropriado realizar testes de 
significância dos coeficientes da 
regressão, de modo que, quando 
o tamanho da amostra é repre-
sentativa da população, o erro 
padrão dos coeficientes estima-
dos deve ser diferente de 0. 
Assim, com base nos resultados 
da Tabela II, observa-se que 
para o presente trabalho, o nú-
mero de amostras foi representa-
tivo da população para as ambas 
as culturas avaliadas, pois o erro 
do coeficiente foi significativa-
mente diferente de 0. Isso signi-
fica que um aumento de uma 
unidade de ‘x’ é associado com 
um aumento de ‘y’ e que ao 
longo de todas as possíveis 
amostras que possam ser consi-
deradas, o coeficiente de regres-
são será diferente de 0, de forma 
que os resultados podem ser 
considerados generalizáveis para 
qualquer amostra da população, 
no intervalo de medida calibrado 

(Tabela II). Ao contrário do co-
eficiente, segundo Hair et al. 
(2005), o valor do intercepto 
apropriado para representar a 
população é zero, e no presente 
trabalho observa-se que apenas a 
estimativa da área real via mas-
sa seca dos limbos de caju e 
soja não diferiram do valor 0 
(Tabela II). Se o intercepto não 
for diferente de 0 é devido a 
erro amostral e, conforme Hair 
et al. (2005), é melhor removê-lo 
para fins preditivos.

Conforme Larson e Farber 
(2010), quando se t rabalha 
com um modelo estatístico é 
importante que se calcule o 
intervalo de confiança da pre-
visão para conhecer a amplitu-
de média esperada dos valores 
da var iável dependente. 
Portanto, é importante que se 
avalie se os resultados têm ou 
não um erro considerável que 

justif ique ou não uma ação 
corretiva ou complementativa. 
Diante disso, embora os ajustes 
sejam altamente significativos 
(p<0,0001), observa-se que o 
erro padrão da estimativa na 
previsão da variável dependen-
te foi maior quando se tentou 
estimar a área do limbo foliar 
pela massa seca dos limbos, 
independente da planta estuda-
da, em vez da área estimada 
por medidas lineares (compri-
mento x largura) (Tabela II).

Observa-se que o maior erro 
encontrado foi na estimativa da 
área do limbo foliar do milho 
pela massa seca, a qual variou 
±39,643cm2, mas essa amplitude 
apresentou níveis aceitáveis para 
o uso do método de estimativa 
da área do limbo foliar via 
massa seca. Segundo Hair et al. 
(2005), o pesquisador deve jul-
gar a luz da signif icância 

teórica e prática perante o pro-
blema da pesquisa investigando 
se o erro é aceitável para justi-
ficar o uso. Diante disso, deve-
-se usar os erros na previsão 
não como uma falha ou algo 
que simplesmente deve ser eli-
minado, mas como um ponto 
de partida para diagnosticar a 
validade dos resultados obtidos 
e uma indicação das relações 
restantes sem explicação.

O erro padrão da estimativa 
(EPE) mede o desvio médio 
entre os valores reais de Y e os 
valores estimados de Y’, de 
modo que o EPE seria igual a 
zero se todos os pares de dados 
utilizados na estimativa do mo-
delo de regressão linear simples 
estivessem sobre a reta ajustada 
(Figura 5). Nesse caso, a reta 
da regressão explicaria perfeita-
mente a relação entre X e Y, 
entretanto, a ocorrência de um 

TABELA II
REGRESSÃO ENTRE A ÁREA REAL DE LIMBO FOLIAR COM MEDIDAS LINEARES E DE MASSA SECA

Planta Medida
Intercepto Coeficiente

N r R2 Prob. Fc>Ft EPE 
(cm2)

Calibração (cm2)
y0 a Mín Máx

Algodoeiro L -0,185 ±3,283 ns 0,881 ±0,017** 30 0,995 0,989 <0,0001 8,689 21,585 281,920
MS 6,748 ±5,755 ns 171,905 ±5,907** 32 0,982 0,965 <0,0001 15,812 13,924 299,063

Cajueiro L 1,760 ±2,284 ns 0,729 ±0,018** 34 0,990 0,980 <0,0001 6,137 12,685 187,790
MS 14,049 ±5,923* 120,822 ±8,988** 35 0,920 0,846 <0,0001 17,056 9,555 142,727

Soja L 3,714 ±3,182 ns 0,675 ±0,020** 25 0,990 0,980 <0,0001 8,609 9,455 198,130
MS 14,633 ±5,252* 226,934 ±12,106** 25 0,969 0,939 <0,0001 15,276 5,945 187,152

Milho L -2,945 ±4,178 ns 0,828 ±0,009*** 28 0,998 0,997 <0,0001 15,326 2,340 697,838
MS 12,219 ±10,542 ns 155,118 ±4,600*** 28 0,989 0,978 <0,0001 39,643 1,349 675,476

 Utilizou-se o modelo linear (y= y0 + bx), em que y: área real estimada via imagem digital (ImageJ), x: área estimada via medida linear e via massa 
seca, em que y0 e a: coeficientes estimados; N: número de pares de dados usados para ajustar o modelo; r: coeficiente de correlação de Pearson 
(p<0,0001); R2: coeficiente determinístico; EPE: erro padrão da estimativa. 
*** (p<0,0001), ns: não significativo (p>0,05) pelo teste t.
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modelo perfeito dificilmente 
será observado (Naghettini e 
Pinto, 2007). Portanto, o erro 
padrão existirá sempre que o 
poder de explicação modelo 
ajustado não coincidir com os 
valores observados.

O valor do EPE significa en-
tão que existem outros fatores 
que interferem no comportamen-
to da variável estimada Y’ além 
da variável X e, assim, será uma 
estimativa aproximada de um 
valor de Y’ para um dado valor 
de X. De qualquer forma, é uma 
medida importante da variabili-
dade dos pontos amostrais acima 
e abaixo da reta de regressão. 
No presente trabalho os erros 
podem ser explicados tanto para 
as medidas lineares quanto para 
as medidas de massa seca dos 
limbos foliares. Conforme Cairo 
et al. (2008), a estimativa da 
área de uma folha por meio da 
relação entre o maior compri-
mento e largura da folha resulta-
rá em uma figura geométrica do 
tipo retângulo. Entretanto, esse 
método expressará valores supe-
restimados, já que a área da fo-
lha não abrange os cantos de um 
retângulo. Além disso, segundo 
Adami et al. (2008), se a folha 
não estiver íntegra, ou seja, da-
nificada, essa superestimação 
pode ser ainda maior, entretanto, 
quando o método leva em consi-
deração esse dano a medida da 
área foliar é muito confiável.

Já no caso de medidas de 
massa seca de folhas a fim de 
estimar a área real, existem fa-
tores naturais implícitos que 
interferem nos resultados, como 

a espessura foliar em função da 
localização na planta, já que 
conforme Kerbauy (2012) so-
mente as folhas adultas, com-
pletamente expandidas e efeti-
vamente expostas à radiação 
solar, podem ser consideradas 
como área foliar fotossintetica-
mente útil. Assim, folhas situa-
das em posições inferiores e 
internas nas plantas estão sujei-
tas ao sombreamento, o que 
torna sua atividade fotossintéti-
ca limitada. Mesmo entre as 
folhas mais expostas à radiação 
plena, é necessário considerar 
que nas folhas jovens, ou em 
fase inicial de crescimento, o 
aparelho fotossintético ainda 
está sendo estruturado (Cairo 
et al., 2008). Portanto, duas fo-
lhas podem apresentar mesma 
área, mas massa seca diferente.  
Esta discussão ajuda a esclare-
cer porque os valores do inter-
cepto não foram diferentes de 
zero na estimativa da área  real 
via massa seca dos limbos de 
caju e soja (Tabela II), pois co-
letou-se folhas pequenas, que 
provavelmente não estariam 
completamente desenvolvidas o 
que, conforme Hair et al. 
(2005), seria o erro amostral.

Para avaliar se o erro padrão 
da estimativa do modelo esta-
tístico poderia comprometer o 
uso dos valores oriundos da 
estimativa da área do limbo 
foliar pela massa seca tomou-
-se como exemplo os dados de 
massa seca do limbo foliar de 
diferentes estádios fenológicos 
da cultura da soja e do milho 
por meio da coleta de várias 

amostras de plantas à campo, 
calibrados com a equação res-
pectiva (Tabela II), e estimou-
-se a área do limbo foliar du-
rante os estádios fenológicos 
da cultura (Figuras 6a, b). 
Quando pretende-se estimar a 
média de uma população com 
variância desconhecida através 
de amostras simples, pode-se 
utilizar do parâmetro ‘intervalo 
de confiança da média’ (IC) 
para assegurar valores prová-
veis à um determinado nível de 
confiabilidade (1-α), de tal for-
ma que quanto menor o IC 
mais confiável será a estimati-
va da média da população. 
Dessa forma, observou-se um 
grande incremento da área fo-
liar ao longo do ciclo da soja 
(Figura 6a) e do milho 
(Figura 6b); além disso, obser-
vou-se que os IC aumentam 
com a idade da planta.

Com isso, ao fazermos com-
paração do erro padrão da esti-
mativa (EPE) do ajuste da soja 
e do milho pela massa seca 

(Tabela II), verificou-se que 
esta variação foi muito menor 
do que naturalmente ocorreu à 
campo, o que é esperado quan-
do consideramos no espaço as 
inter-relações solo-planta-atmos-
fera em uma área agrícola com 
plantas cultivadas e, isso, por-
tanto, representa  níveis aceitá-
veis para o uso do método de 
estimativa da área do limbo 
foliar via massa seca, pois ao 
nível de 5% de probabilidade o 
verdadeiro valor da média po-
pulacional da área do limbo 
foliar (cm2·m-1) da soja 
(Figura 6a) e do milho 
(Figura 6b) poderia variar bem 
mais que o próprio EPE de 
±15,276cm2 e ±39,643cm2, res-
pectivamente, verif icado no 
ajuste da calibração (Tabela II). 
Portanto, pode-se usar segura-
mente a massa seca do limbo 
foliar das plantas avaliadas para 
estimar a respectiva área foliar 
de maneira simples e rápida.

Conclusões

A estimativa da área do limbo 
foliar de plantas de algodão, caju, 
soja e milho pode ser obtida ba-
seando-se em medidas lineares e 
de massa seca das folhas, utili-
zando o software ImageJ para a 
calibrar essas medidas.
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Figura 6. Estimativa da área do limbo foliar (cm2·m-1) em diferentes estádios 
fenológicos da cultura da soja (a) e do milho (b). A imprecisão associada à 
estimativa da média de cada estádio foi calculado pelo intervalo de confian-
ça (IC) (α=  0,05), conforme Larson e Farber (2010), com os seguintes nú-
meros de amostras simples. Soja, n= 80 (V1), n= 101 (V2), n= 101 (V4), n= 
101 (R1), n= 80 (R2), n= 96 (R3), n= 64 (R5.3), e n= 98 (R7.2). Milho, n= 
59 (V1), n  59 (V8), n= 59 (R1), n= 59 (R4), e n= 59 (R5).


